Budget – 1st Payroll of New School Year
Part 4

[image: image104.png]Date Run Outstanding Purchase Order Listing Program: FIN2150

Caty Dist: Page:1of 1
Sort Order: Fund/Fscl Ye/PO/ACCT Asof June File ID: C
PO Vend
Nor Date Vendor Name Noc Reason Find-Fnc-Obj.So-Org-Prg Balance

30192 12032019 WINKEDUCATIONAL 00043 AG SHOP PROJECTS 199-11:6395.21-001-022000 147.00
302038 12202019 WYLIE MANUFACTURING 00014 SUPPLIES 19951:6299.00.993.099000 5000
199:51-6315.00:935-095000 10000 10000

19951:6316.00.993.099000 25000 25000

19951:6317.00.993.099000 15000 15000

19951:6397.00.993.039000 5000 5000

Totals for P.0. 302038 - SUPPLIES 600.00 600.00

02040 12202019 ULNE 00275 SUPPLIES 19951:6316.00-993.03000 10000 10000
193:51-6317.00.993-09%000 10000 10000

Totals for P.0. 302040 - SUPPLIES 200.00 200.00

02088 01152020 VOSS LGHTING 00182 POCREATED BYREQ:  199-11:6395.00-101-023000 5737 5737
199-11:6395.01-101-023000 2% 294
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30209 01162020 VOSS LIGHTING 00182 POCREATED BYREQ:  199-116399.00-101011000 17760 17760
30207 01162020 UNITED REHAB 00261 POCREATED BYREQ: 199116249, SW-933.095T00 408605 408505
02123 0607:2020 FLAGHOUSE 02828 US Rlags 13941:6395.00-750.099000 7500 7500

Totals for Fund 19970 6.116.04 5.763.04





Presented by ESC, Region 14

July 2020
Part 4 Checklist

This part of the process begins with August Accruals.  
· The August Accrual process posts wages for employees who begin work for the new school year in July or August, but do not receive their first paycheck until September, which falls in the next fiscal year. 
·  We recommend completing the August Accrual process on all 10 month employees who receive their first paycheck for the new school year in September.  
· Hourly Employees and employees who work 11 or 12 months are typically excluded from this process. 
The following should be completed before beginning this process:

_____ Teacher Service Records. See separate document.  

_____ Roster of Personnel - HRS 1000 run report and save for auditor file – (Best to do in May)

_____ August Payroll
_____ August Deduction checks
_____ August TRS Reporting -  Files Extracted, Create and Interfaced – DO NOT SEND AT THIS TIME. (We will send on Step 80)
_____TRS On-Behalf (if not posted monthly, book annual amount before starting August Accruals) Can be verified by reviewing Finance > Inquiry > General Ledger Inquiry for 199-00-5831-00.
_____ Any employee that previously terminated but is now re-employed by your district must have the termination date and reason removed for the August Accrual process.
_____Termination dates and reasons must be entered on the Employment Info screen for all employees who are no longer at your district.  Date should reflect the last day of instruction or work.

_____Next Year Payroll must be completed including entry of all new employees and inactivation of all employees not returning to your district for the new school year.  Additionally, you will want to inactivate any vacant positions or position holders you may have created for budgeting purposes
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Log into the Current Payroll Frequency
_____ Balance Accruals in Finance and HR.  (Separate Document)
You are now ready to begin the                          August Accrual Process.
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GASB Statement No. 24 - 2019 Estimate Now Posted

“The Governmental Accounting Standrds Bozrd (GASS) Statement 24, Accounting and Fiancial eporting fo Certain Grants &nd Other Financial Assistance, was issued June 1994 and effectivefor periods
beginning after June 15, 1995, Tns statement estabishes accounting and financial réportng standards for pass-through grants, food stamps, and on-aehalf payments for fringe benefts and salaris.

ATTENTION: TR Reporting Officals

“The Teacher Retirement System of Texas is furishing this information to assist reporting entties in complying with the GASB requirements. Certain information required by GASB 24 will have to be derived from
the reporting entity's payroll records. Please forward this document to your reporting enity's financia/accounting manager and your audtor

ANNUAL FINANCIAL REPORT OF NOTES TO THE FINANGIAL STATEMENTS

Per GASB 24, paragraph 12, r&portng entites shou's disciose inthe notes to th fnancil statements
REPORTING ENTITY FINANCIAL STATEMENTS e smounts recognizes for on-benalf payments for frnge beneis 2nc salries. For on-oenalt

payments that are contrisutions o the pension plan, see GASS 68 nstructions.
(5458 24 requires reportng entiles to recognize revene and eypenditures expenses for on-oznt

payments nthei inancial statements. On-benalf payments for fringe benefis and salaies are airect
payments made by a paying enfit o a third-party recpient forthe employees of an employer entiy.
‘Types of On-Behalf Payments:

State Contributions - Contrinutions made by the State of Texas to te Teacher Retirement System
(TRS) of Texas on behalfof & reporting entiy's employees must be recogrized a5 eaual fevenues ang
expenditures/expenses by each district. Section 1.3.3 of the Texas Eaucation Agency's (TEA) Financial
Accountabilty System Resource Guide provies & detailed explanation and example. Glck on he ink
below to otain the most recent version o the TEA Financial Accountabilty System Resource Guide

“TEA Financial Accountability System Resource Guide.

Federal Goverment Retiree Drug Subsicy - The Medicare Modemization Actof 2003 (MWA) created an
outpatient pescription drug benefit program (known &5 Medicare Part D) and  Retiee Drug Subsidy
(RDS) program which were made avaizble in 2006. The Texas Pudlic School Retred Employee Group.
Insurence Program (TRS-Care) is offerng & Medicare Part D Blan andis prticipating it Retree Drug
Supsidy pln for elgible TRS-Care participants. Under Medicare Part D and the RDS program, TRS-Care
receives payments from e federsl govemment to offset certain prescription drug expenditures for
il TRS-Care sarticpants. On-08nsif sayments must 2 recognized a5 equsl reienes ang
eipenditures eipenses by exch eperting entty.

The sllocation of these on-ozhalf payments is based on the 1310 of 2 reporting entiy s covered payrol
0 the entre covere payrall reportes by 3l partic pating reportng entites TS based tis 3location
percentage on the'completed” report submissions by reporting entties forthe month of May. Any.
questions about payroll amounts should be irected to a reporting entit's payrollcontact.

Ciick on the fink below to obtain 3 sting of each reporting entitys porton of etiree cug subsicy
received by TRS for each fscal year ending August 31,
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Log into HR - Next Year Payroll Frequency

_____ 69. 
Populate the EOY Accrual Table.  
Payroll Processing > EOY Payroll Accruals > Accrual Table tab
A. Select Table Type - Daily 
B. Click Populate Table.
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The popup box will display available contract begin dates from Next Year Payroll.  
· Check the Delete box for any beginning dates that you do not want included in August Accrual calculations, 
· Select the box in front of the Start dates for 10 month employees that should be included, and enter the ‘Estimated Days’ worked in August by those employees.  
· Execute. 
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You will have a popup that shows Loading. You will not have anything to show that it Updated. When it’s finished click Cancel. 
When you close the window, your Accrual Table will be populated with the Start Date, Estimated Days and Job Codes associated with the Start Dates selected in the previous action.  Review for accuracy, then click Save.  
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_____70.  On the Decrement tab, add any funds you do not want August Accruals to decrement the fiscal year on. TxEIS will automatically change Year 1 to 0 unless you specify the Fund Codes here.  For example, several of you have Head Start grants that ended in April or May.  After that, you opened up Fund 205/1. You don’t want 205 to decrement to a fiscal year 0, so add that fund here.  

NOTE:  Some auditors have indicated they prefer to have you decrement everything and then let them provide entries to move everything applicable to the new (fiscal year 1) account code(s).  If that is the case for your district, skip this step. 
Use the +Add to indicate funds you Do Not want to decrement and Save.
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_____ 71.  Run Calculations.  On the Run Calculations tab: 

· Enter the Calculation Date as 08-31-2020.
· Check the Exclude Non-Standard Employees box – these are the 11, 12 and 13 month contracts that receive their first check of the new school year before September.  They should have the TRS Year box checked on their Job Info screen.
· Check the Exclude Substitutes box
· Pull all employees from the left window to the right window using the double right arrow.

· Click Run
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· Preview / Print the Error Report and click Close.
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Crty Dist: 076-904 ANYWHERE 1SD

Pay Date: 08-31-2020 School Year: 2021

Emp Nor Employee Name Failure / Waming Message

000538 ANISTON, JENNIFER Failure: No Data in EOY Accrual Tablefor Pay Type: 1, ob Cods: 0656, Cortract Begin Date:
0901:2020.

000465 BOGART, HUMPHREY Waring: No Data in EOY Accrual Table for Pay Type: 2. Job Code: 0701, Cortract Begin Date:
0901:2020.

000465 BOGART, HUMPHREY Waring: No Data in EOY Accrual Table for Pay Type: 3, Job Code: 0950.

000465 BOGART, HUMPHREY Faiure: No Data in EOY Accrual Tablefor aljobs.

000205 BULLOCK. SANDRA Waring: No Data in EOY Acorual Table for Pay Type: 3, Job Code: 0950.

000504 CAGE. NICOLAS Failure: No Data in EOY Accrual Tablefor Pay Type: 2, Job Cods: 0711, Cortract Begin Date:

09-01-2020.




Review all messages and make corrections as needed—REMEMBER—the employees with Failure Messages on this list will NOT be included in the EOY Accrual calculations. Common errors and the corrections include:
· Warning: Job Code XXXX, State Min Days = 0 and/or Daily Rate = 0 which may affect TRS TEAM 373 or Non-OASDI calculations

Add State Min Days Field on the Job Info Tab. 
· Failure: No Data in EOY Accrual Table for Pay Type: 2, Job Code: XXXX, Contract Begin Date: 08-XX-2020.

Employees may be on the report if the beginning contract date on the Job Info screen hasn’t been updated (note year 2018).
· Failure: No Data in EOY Accrual Table for Pay Type: 2, Job Code: XXXX, Contract Begin Date: 09-01-2020.
Disregard Error. Employee does not work any days in August so they do not accrue. 

· Failure: No Data in EOY Accrual Table for Pay Type: 1, Job Code: XXXX, Contract Begin Date: 07-01-2020.
Employees with contract begin dates in July or August that are paid prior to September should not be on this report. If they show, check the TRS Year Box on the Job Info Screen. 
· Failure: No Data in EOY Accrual Table for Pay Type: 3, Job Code: XXXX,
Employees who are a Pay Type 3 (Hourly) show on the report. We do not calculate August Accruals on Pay Type 3 so you may disregard those errors.
NOTE 1: Employees with termination dates AND reasons will not extract for August Accruals.  If you see terminated employees listed, ensure both fields are populated on their Employment Info screens.
NOTE 2:  If corrections are made in the employee screens, consider whether the EOY temporary tables need to be cleared, then you must return to Step 69 and repeat from there.  You may correct and repeat the process as often as necessary to obtain accurate information.  

_____72.
Print and Review Accrual Reports.  
Next Year Pay Frequency > Payroll Processing > EOY Payroll Accruals > Accrual Reports Tab. 
Review the reports for accuracy. Once accurate, we recommend you save a pdf copy of the reports in your Auditor folder as well as your 2020-2021 Budget – 1st Payroll folder.  From the Accrual Reports tab, print and/or save the following:
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EOY Accrual Table Hourly or Daily (HRS9900/HRS9910) displays 
the number of days you assigned to each start date in Step 69. 
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EOY Accrual Information (HRS9920) lists all employees included in 

EOY accrual calculations.  Verify the following:

· Daily accrual rate, and accrued pay seem reasonable. 

· All employees paid from federal funds are calculating TRS Federal Grant and Fed Care amounts. 

· All 10 month employees have an accrual code.

· Review Accrual Information listing for employees that should not be included in accruals, or employees that should be in accruals but are missing from the report.
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00014 WYLIE MANUFACTURI 001 School 508544 C  Supples 7% N
199-11-6395.21-001-022000
001 School 301741  ASSORTED C REVERSAL 42581 N
1991146395 21001022200
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101 School 301886 000006278 C ROBOTICS CAMP FOR TE 19999 N
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Check Total: 37.92
Vendor 00190 Total 3792
Grand Total: 31382

End of Report
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EOY Accrual Distribution by Account Code (HRS9930) lists all employees 
accruing in each account code with detailed accrual amounts.  Verify the following: 
· [image: image103.png]— ) ()
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Date Run: Mass Purchase Order Reversal Report Fund / Year
Crty Dist: 1sD Page: 1 of 1
File ID:C
E Vendor Name. Reason
199-116395.21-001022000 00043 - WINK EDUCATIONAL CONSULTING. INC _ AG SHOP PROJECTS
302038 5000 199516299.00999099000 00014 - WYLIE MANUFACTURING CO. SUPPLIES
302038 10000 19951631500999099000 00014 - WYLIE MANUFACTURING CO. SUPPLIES
202038 25000 199516316.00.993039000 00014 - WYLIE MANUFACTURING CO. SUPPLIES
302038 15000 199516317.00993099000 00014 -WYLIE MANUFACTURING CO. SUPPLIES
302038 5000 199516397.00999:099000 00014 - WYLIE MANUFACTURING CO. SUPPLIES
302040 10000 199516316.00999095000 00275 ULINE SUPPLES
302040 -10000  199516317.00999099000 00275 - ULINE SUPPLIES
302088 5737 19911639500101023000  00182-VOSS LIGHTING PO CREATED BY REQ: 302100
302088 2394 19311639501101023000  00182-VOSS LIGHTING PO CREATED BY REQ: 302100
302089 7201 19911639500041023000  00182-VOSS LIGHTING PO CREATED BY REQ: 302101
302090 15920 199216397.00.999023000  00182- VOSS LGHTING PO CREATED BY REQ: 02102
302093 7523 19951631600999099000 00480 - THE BACH COMPANY SUPPLES
202093 948 19951631700999099000 00480 - THE BACH COMPANY SUPPLIES
302035 8016 199516316.00999093000  00015- WRITING CLAW. INC. SUPPLIES
302096 7760 199114639900101011000  00182-VOSS LGHTING PO CREATED BY REQ: 302109
302097 408605 199-116249.5W-993095T00 00261 - UNITED REHAB SPECIALISTS. INC. PO CREATED BY REQ: 302110
02123 7500 19941639500750099000 02828 - FLAGHOUSE US Flags

End of Report




Account Codes are correctly assigned.
· August Accruals are being coded to the correct fiscal year 
· Federally funded employees show Fed Grant and Fed Care amounts

· Fed Grant and Fed Care amounts do NOT display on employees coded to state or local funds
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EOY Accrual Distribution by Alpha, (HRS9940) gives the same information as the EOY Accrual Distribution by Account Code except that it is in Alpha Order.  Review for accuracy. 
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EOY Accrual Account Code Comparison, HRS9950 displays accounts that are being used in August Accrual calculations that do not exist in Finance. If you have accounts on the account code comparison report, determine what must be corrected to resolve the discrepancy before continuing. This report must be clear of accounts to continue. Correct account code and re-run until report is clear.
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NOTE:  Each time corrections are made to the employee records or to the Accrual Table, you must clear the EOY accrual tables, begin at step 69 of this process and reports must be printed and reviewed again.  Do not proceed until all reports are reviewed and found accurate.
_____73.  Create the General Journal.  On the Create General Journal tab, enter JV Number AUGACC.  Select the August Accrual line and Execute.  Accrual objects will include 216X – accrued wages and 221X-XX –benefits. 
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Verify the JV by comparing the amounts for each fund with those displayed on the EOY Accrual Distribution by Account Code (HRS 9930) printed and saved in Step 72. Save the General Journal as a PDF report. These totals must match for each fund.  If they do NOT, you must stop and make corrections.  
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If accurate, Save as Pending. If you discover the totals do not match after you have Saved as Pending, you must complete Step 74.
If the totals match, proceed to Step 75.
STOP!!! Read before proceeding.
_____ 74a.  Complete this step ONLY if you find errors or discover totals do not match after having clicked ‘Save as Pending’.  This step will clear the JV that was just created.
· Go to the Interface to Finance tab, select the line, click Delete Pending.
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· Change to the Current Payroll Frequency.  Go to Next Year > Copy CYR Table to NYR > Clear Next Year Tables tab. 
· DO NOT bring tables to the right!
· Check the ‘Clear EOY Accrual Data Only’ box

· Click Execute
[image: image18.png]CEEEEEEEEEEEEEEEEEELE

‘Accrual Calendar
Extra Duty Pay

Hourly / Daily Salary

Job Code

Local Annual Salary

Midpoint Salary

School Calendar

State Minimum Salary
Substitute Salary

Workers' Compensation Rates
Employee Bank Record
Employee Deductions
Employee Extra Duty
Employee Job

Employee Pay

Employee Pay Distribution
EOY Accrual Calendar

EOY Accrual Data

EOY Accrual Fund Decrement
NY Payroll Budget

rict #: 067908





· Change back to the Next Year Pay Frequency.

· Make changes as needed 
· Start at Step 69 again. 

_____74b. Make a backup.  From Utilities > Export by Human Resources by Payroll, select both pay frequencies and Execute.  Once the backup is complete, start at step 69.
_____75.
Interface to Finance in the Next Year Pay Frequency.  From Payroll 
Processing > EOY Payroll Accruals > Interface to Finance tab, enter the following:
· Post to Accounting Period 08
· Enter the 08-31-2020 as the Interface Transaction Date 
· Select the August Accrual line

· Click Preview Report before you Interface to verify information  

Review General Ledger entries to ensure they match the desired totals.  The Emp Report will show amounts that will interface by employee.  Review and save this report. 
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· Once you have verified the General Journal, you can Interface.
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Special Consideration:  This is a good time to review expenditures, particularly for Federal Funds and Maintenance of Effort (MOE).  If payroll expenses need to be adjusted, make those adjustments through Current Year > Human Resources > Payroll Processing > Special Adjustments > Expense Only tab.  Choose to Post to Master and Interface to Finance so that HR and Finance still match.  

Log into the Current Payroll Frequency

_____76.
Mass update all employees account code fiscal year to 1 in the 
Current Payroll Frequency > Utilities > Mass Update > Employee tab:
· Select Pay Status: Active
· Check Fiscal Year and enter 1 in the box to the right
· Execute

· Process
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_____77.    Create a Backup for CYR and NYR and save in sub folder for Step 77.
HR > Utilities > Export Human Resources by Payroll
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Log into the Next Year Payroll Frequency
_____78.
Move all Next Year Tables to Current Year.  
Next Year > Copy NYR Tables to CYR
Select All tables then click Execute.  Process each Preview. 
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Due to a program issue, School Calenders must be moved seperatley. 
· Uncheck tables that were just copied. 
· Select the ellipses beside School Calendars.

· Select one calendar at a time and copy. Continue untill all calendars except TR and Summer School have been copied (TR calendar will be copied in a later step). 
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_____79. 
Move remaining employees from Next Year Payroll to Current Year.  
In the Next Pay Frequency, from 
Next Year > Copy NYR Staff to CYR,
· Select Pay Status Active.  Carry Over Employee Deductions only if deductions were updated in Next Year.  
· Enter the Extract ID
· Include Employees with Term Date if needed 
· Execute.
· Make backup when prompted
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Review the Copy Staff Employee Listing to ensure only 10 month employees are displayed. DO NOT Process 11 or 12 month employees. If accurate, Process. Repeat for all 10-month employee Extract ID groups. 
Now we have ALL of NEXT YEAR PAYROLL into CURRENT!!!
Log into the Current Payroll Frequency
_____80. Re-extract TRS, Create Files and Send to the RE Portal for August.

 DO NOT INTERFACE AT THIS TIME. 
_____81.
Post August Accruals to the Master Payroll file.  This step MUST be run before September payroll.  Post to Master updates the employee information in current year payroll and year to date accrual distribution.  It adds the accrued pay, accrued days and benefits to School YTD fields and creates a new school YTD for the employee.  
Current Payroll Frequency > Payroll Processing > EOY Payroll Accruals > Post to Master tab
Select the August Accrual line.  
Click Post 
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______82.   Verify the August Accrual Data posted to the School YTD screen in the Current Payroll Frequency. 
Maintenance > School YTD Data
Enter school year 2021.  Retrieve any 10-month employee.  Verify the accrual data has been posted including accrued wages and benefits, and the number days earned. 
Note: If you do not change to School Year 2021 it will be blank in the Accrued 
Data Box. 
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_____83.    Update the HR Options Table. 
Current Payroll Frequency > Tables > District HR Options
· Automatically Compute – recommend all rates be checked
· School Year for PEIMS Codes - Enter the current school year = 2021
· Set the first pay date of the school year.  This is the first payroll, regular or supplemental, for the new school year.
· Save changes
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_____84.
Mass Update Leave.  Refer to our document on Resetting and Updating Leave Balances, available on our website.  
_____85.  
Import Deduction Changes from your Third Party Administrator (TPA) or Mass update deductions.  If you have received a file of changes from your TPA, refer to the Employee Benefits Interface Checklist on our Website. Deductions not managed by your TPA can be updated through Mass Updates.   
Utilities > Mass Update > Deductions tab
· Change Existing Code and Amounts to Another:  If you have changed from one insurance provider to another, this will allow you to change everyone over to the new company en masse.  
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· Change Dollar Amount on Existing Code:  This is common when insurance premiums change.  This method will allow you to choose the applicable deduction code, then change the Net Amount (Employee amount) and/or Employer Contribution from one amount to a new amount.
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· Add a new Deduction Code to Employees:  works great if you are now offering a new benefit such as pre-paid legal.  Once the new deduction code has been entered into the table (see step 8), select the new code, the Net Amount (Employee portion), the Remaining Payments, and the Employer Contribution.  Check if Cafe125 is applicable and Execute.
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· Delete Deduction Code from Employees:  If you will no longer offer a particular deduction and want to delete that code from all employees, this is your best bet.  Simply check applicable deductions and Execute.
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_____ 86.
Review eligible retirees for TRS Pension Surcharges and Care Surcharges.  Check each retiree in the TRS RE Portal to determine whether the Pension and Pension Care Surcharge might be due. Pension surcharges are due on all employees who retired after September 1, 2005 and work more than half-time in positions that are normally TRS eligible.  Care surcharges are due on those retirees who retired after September 1, 2005 and take TRS Retiree Insurance.  

To ensure Pension surcharges are accurately paid, check the Take Retiree Surcharge box on eligible retirees. 
Maintenance > Staff Job/Pay Data > Employment Info screen
This box should have been unchecked during the summer, as surcharges are not due during months’ retirees are not physically working on your campus.  The TRS Pension Surcharge will be 15.2% for the 2020-2021 School Year. (Member TRS Rate + District TRS Rate) 
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Verify that the TRS Care Surcharge Deduction code is listed under 

HR > Tables > Tax Deductions > Deduction Cd
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Pension Care Surcharges (Insurance) must be added to each applicable retiree. 
Maintenance > Staff Job/Pay Data > Deduction screen
Add a row for the deduction code, selecting the deduction code for TRS Care Surcharge.  Enter the amount in the Emplr Contrib field with 99 remaining payments and Save.
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Note:  If you have an agreement with the retiree to pay the district back for these surcharges, review that deduction as well. To repay the district, a second deduction must be entered, using a deduction code with the district as the vendor.

_____87. 
Add September pay date 
Tables > Pay Dates 
· Select +Add and add your September paydate. At this point, we are only concerned with the September pay date. Additional Pay Dates will be added in another step. 
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The next part of the process covers the Finance Fiscal Year close.  
The following should be completed before beginning the Finance Process 
Log into Budget
_____ Enter TRS On-Behalf Revenue in Budget.  NY Payroll budgets for On-Behalf expenditures, but not revenue.  

A. Pull a Summary Report for object 6144.00.  The Appropriations shown for each fund must be budgeted in XXX-00-5831.00.
Budget > Inquiry > Budget Account Code Inquiry,
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B. Add amount from the report in: 
Maintenance > Budget Data > Tab desired, 
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_____ Budget Medicare D Revenue and Expenditure.  Amounts can be retrieved from the TRS Website: www.trs.texas.gov > 

Reporting Entities > Governmental Accounting Standards Board (GASB) > GASB Statement
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Scroll down near bottom of page.  Click link for Medicare Part D: On-Behalf Payments (pdf).
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A. Enter the Budget Revenue in 199-00-5831.01.
Budget > Maintenance > Budget Data 
Select the tab that you are working in your budget. 
(Example: Recommended)
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B. Enter the Budget matching Expenditure in 199-11-6144.01
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Log into Finance
_____ Ensure Medicare D (Realized Revenue and Actual Expenditure)

are booked in Finance in File ID C.
Finance > Inquiry > General Ledger Inquiry
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If Medicare D has not been booked enter a journal entry from:

Finance > Maintenance > Postings > Journal Actual
199-00-5831.01 Credit Amount $470,883 *

199-11-6144.01 Debit Amount   $470,883 *

*Sample amount only. 

Use the amount listed for your district on the Medicare Part D On-Behalf of payment list retrieved in a previous step. 

You are now ready to begin the Finance Fiscal Year close.

Log into the Current Year Finance.
_____90.  
Make a backup of Finance before beginning this process.  
Utilities > Export by File ID
Select File ID C from Available File IDs, pull to the right and Execute.
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____ 91.  
Reverse outstanding Purchase Orders.  Generate the outstanding Purchase Order Report from 
Finance > Reports > Finance Reports > Vendor/Purchase
Order Reports > FIN2150 - Outstanding Purchase Orders
[image: image47.jpg]RegortID: FIN21S0
el ¢
User D:

Cure per
Nextper:

fAccounting Period Current (C), Next (N)

Select Contract €}, Non-Contract(N), o blankfor ALL

s 05 Vercr g er s Grsoon sosesonnkro . [ ()
[P S— —— |

————— 100






[image: image48]
Determine the POs that need to be reentered and which Fiscal Year they will need to be expensed in.  All POs should be reversed and re-entered in the correct File ID.
Reverse POs from 

Finance > Utilities > Fiscal Year Processing > Mass Purchase Order Reversal > Reverse PO by Fund

Pull all funds to the right and Execute.  Process at the Preview.
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[image: image50]
____ 92.  
Address any unprocessed Payment Authorizations.  Generate a YTD Check Payments List for unpaid checks from 

Finance > Reports > Finance Reports > Journals, Checks, Detail Ledgers > FIN1750 – Year to Date Check Payments List


Unprocessed checks must be reversed or processed.
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_____ 93.  Delete any Pending Payables.  If using the Receiving function in Purchasing, items received are listed in Pending Payables to be paid.  If you are not using Receiving, this step may be skipped.
Maintenance > Pending Payables

Note:  If you have several pages of pending payables to delete, contact the ESC to run a script to mass delete.  This will be available as a Utility next year.

[image: image53]
_____ 94.  Prepare File IDs.  The closing step will automatically move the Current File ID C to File ID 0 for historical reference.  Determine if you have a File ID 0 currently (2009-2010) and whether you wish to keep that history.  If you want that history, complete step 94a.  If not, skip to 94b.
94 a. Copy Current Finance information to File ID 0 for history. 

· Change to File ID 0.  
Utilities > Move Current to New File ID,

· Choose an alpha character, not currently being used for the New File ID that you will be calling 2009-2010, but do not use ‘C’. C is always used for the Current File.

· Check the Select button to select all the Fund/Year’s.

· Ensure the Copy radio button is selected and NOT Move. 
· Execute
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At the prompt, verify you want to copy data from the current File ID (0) to the new File ID by clicking Yes.
Verify all funds/account codes and amounts have been copied to the new file ID.  

Finance > Reports > Finance Reports > Summary/Miscellaneous Reports > FIN3050 - Board Reports.

For the Parameters/Values select Recap to print in both File ID C and File ID 0 and compare totals of Revenues and Expenditures.
Stop!! Change back to File ID C.

Note:  You must NOT be in File ID 0 when you delete it or you will be caught in a loop it is difficult to get out of.  Verify you are in File ID C before deleting.

____ 94 b. We need File ID 0 to be clear so we can add the 2019-2020 information. At present, it still has the 2009-2010 information.  This step will delete the old 2009-2010 information. 

Utilities > Delete by File ID,
· Verify that you are in File ID C.  
· Under the Available File ID’s select 0 for 2009-2010 and move to the right under the Selected File ID’s.  

· Execute 
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Choose YES to delete Finance Table for the File ID 0.
Log back into the File ID C in Finance

_____ 95.  Run the Out of Balance Utility.  Correct out of balance issues from 
Utilities > Out of Balance Correction
If out of balance issues exist, this utility will correct automatically and provide a report of entries corrected.
Note: This is a new utility. If you do not have access (it will show it’s grayed out), you will need to add this to your Role ID in Security Administration.  
_____ 96.  Verify only the final accounting period is open.  You must show accounting period 08 (06 for July start districts) in both Current and Next accounting periods.  If 07 – July (05 – May for July 1 start districts) is still open, it must be closed to continue.  
Tables > District Finance Options > Accounting Period tab
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_____ 97.  Close the fiscal year.  The new screen provides a streamlined method of closing the fiscal year.  
Utilities > Fiscal Year Close
Note: This is a new utility. If you do not have access (it will show it’s grayed out), you will need to add this to your Role ID in Security Administration
The following tasks are completed automatically when the Fiscal Year Process is executed:
· 1099 Work tables deleted

· Payroll Deduction transactions deleted

· Payroll Transfer Transactions deleted

· File ID C is copied to the selected File ID for history

· Credit memos are deleted for ending funds, copied to the new file ID for continuing funds, and copied and the fiscal year incremented for continuing funds

· Fiscal year is incremented on all account codes in the funds selected

· Budget amendments deleted 

· New account codes and balance sheets are copied to the new File ID C for all continuing funds

· Balances will be carried forward for incremented funds if selected

· The historical File ID will keep the final accounting period open.  The end of month process is completed in File ID C to open the beginning accounting period (07 for July starts, 09 for September starts) in it 
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· Select 0 for the New (historical) File ID.  

· Enter JV number desired.  

· Choose a date for any historical transactions.  Recommend 08/31/20XX (06/30/20XX for July 1 start districts)

· Choose a date for any transactions automatically created in the new year.  Recommend 09/01/20XX (07/01/20XX for July 1 start districts).
· Execute

The following reports are available for review.  Generate and review/save as desired then click Process.  Reports are displayed one at a time.  As you review/save reports, select Continue to see the next report.  When completed, it will return to this screen to process the close.
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_____ 98.  Exit Finance and then open it back to verify File ID C is in the new accounting period.
_____ 99.  Update District Finance Options 

Tables > District Finance Options
Verify/Update the following and Save. 

· Current Finance Fiscal Year = 1
· School Year = 2020-2021
· Previous Year File ID = 0
· Starting Accounting Period = 09 (07 for July starts)

· Student Activity Fund/Fiscal Year (if using) = 865/1
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_____100.  If it isn’t already there, add Fiscal Year 1 to the Clearing Fund Maintenance tab. 
Finance > Tables > District Finance Options > Clearing Fund Maintenance tab
Retrieve Codes for Fiscal Year 1 OR click the Add button to add Fiscal Year 1. Most Object Codes are populated when new fiscal year is added, but you must fill in your Finance and Payroll Clearing Funds. 
Note 1: If Fiscal Year 1 already exists, Retrieve and verify the Cash and Payable Account objects are accurate and all Payroll Automatic Posting Defaults are populated.  SAVE any changes.
Note 2: If you receive an Error showing ‘Clearing Fund Maintenance – Overpayment Account Code must be 20 digits in length’ when you Save, delete the 1 in the Account Code in Overpayment Account and click SAVE. (This affects the Account Receivables which most districts Do Not use.)

Note 3: If the ‘Accrued Employer Miscellaneous Deduction Contribution’ is blank you must fill it in with 22XX.21 and SAVE.
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Log into Bank Reconciliation
____ 101.
Verify bank account information.  
Bank Reconciliation > Tables > Bank Account Fund Groups > Bank Account Group Funds Tab
· Select the Group Code. 

· Verify that the Fiscal Year is X or change from 0 to 1. 

· You will need to verify each Group Code. 

· Save any changes

Note: In the past, we were able to Mass Update the Fscl Yr from a 0 to a 1. Now there is not an option to Mass Update. The programmers took out this option with the intent of everyone using the ‘X’ so you will not have to change years. 
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Log into Budget
____102.  Verify that your funds are in balance.  

Budget > Inquiry > Budget Account Codes Inquiry,
Select Totals and Retrieve.  The difference between revenues and expenditures should be zero.  If not, an off-setting entry will be made to fund balance.  Run for all funds.  Federal budgets should NEVER be out of balance.  Make adjustments as needed.
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Fund Balance ) ) ) ) ) ) )
Estimated Revenues 26794 ) 114600 ) ) 114600 )
Other Resources ) ) ] ) ) ) ]
Appropriations 2673 ] 4600 ] ) 24600 )
Other Uses ) ) ) ) ) ) )




Note:  If you are out of Balance the System will make the offsetting entries to 3700. 
_____103.  Verify your budget is in the Next Yr Approved column 

Inquiry > Budget Account Codes Inquiry
 SHAPE  \* MERGEFORMAT 



If your budget is not in the Next Yr Approved column, go to 

Utilities > Budget Level Processing > Copy Level Tab.
Select the level you want to Copy From, then select Approved for the level you want to Copy To. Click Execute, then Process at the Preview.
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____ 104.
Move Budget to Finance. 

Budget > Utilities > Move Budget to Finance,
· Select to Update the Full Amount 

· Copy Account Code Tables,

· Enter JV Number BUDGET or if you have already used budget you can use ORBUD for Original Budget. 

· Transaction Date of 09-01-2020.  

· Send desired funds to the right. 

· Execute 

· Select Process at each preview. 

Note: This step can also be completed in Finance from Utilities > Fiscal Year Processing > Move Budget to Finance.
 SHAPE  \* MERGEFORMAT 



If funds are not in balance, a preview is provided of the amounts that will be charged to budgetary fund balance (3700).  Select Process to continue.
 SHAPE  \* MERGEFORMAT 



Log into Finance
Once completed, log into Finance > Inquiry > General Ledger Inquiry > General Ledger Account Summary tab and verify budgets were copied.

____ 105.
Address Due To Fund/Fiscal Year for credit cards (if applicable)

Tables > Credit Card Funds > Due to Fund tab

If applicable, determine the fiscal year for credit card entries.  Fund(s) used by credit card processing (see Credit Card Codes tab) must be coded to only one fiscal year. 

  SHAPE  \* MERGEFORMAT 



Log into HUMAN RESOURCES
Current Pay Frequency
_____ 106.  Update the Payroll Clearing Fund/Fiscal Year.
Tables > District HR Options
Select the Fund/FY for the 2020-2021 year for the Payroll Clearing Fund/Year field. Save changes


[image: image69]
_____ 107.  Verify Grant Codes are assigned to all Federal funds.  
Tables > Salaries > Fund to Grant tab
· Add a grant code to federal funds as needed.

· Save any changes
Note:  All Federal Funds except 240 needs a Grant Code. 
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_____ 108. Due to a program issue, pay dates and number of days built in the Accrual Calendars in NY Payroll did not copy over. These must be manually added to Current Year Payroll.

Tables > Workday Calendars > Accrual Calendar tab.
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_____109.  If using Next Year Purchasing, move Next Year Requisitions to Current. 

Finance > Utilities > Fiscal Year Processing > 
Clear/Move NYR Requisition to CYR
· Enter a PO date of 09-01-20XX (07-01-20XX for July starts) 

· Select the radio button to ‘Move Next Year Requisitions to Current and Update Finance’.  

· Execute
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· If you have received an Over Expend Report, then the requisition exceeds the budget.

· If this report generates, click Continue. 

Note 1: Remember that Next Year Requisition does not pull from the Budget. We moved Budget to Finance so we are able to get this over expend report.
*Note 2: The following 2 Screen Shots are from a prior year. You should process for the current school year.
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· The list of requisitions being moved will appear. 

· Process 

· You will receive a popup with “The Move Next Year Requisitions process completed successfully.’
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Log into District Administration
_____110.  Update Purchasing Cutoff Date.  


Options > Purchasing

Update the cutoff dates on both the Current and Next Year tabs as desired.
 SHAPE  \* MERGEFORMAT 



_____111.  Update User Accounts



Utilities > Mass Updated User Accounts by Fund

If funds/fy exist on the right, users have account codes assigned with those specific fiscal years.  Push to the right to increment one fiscal year.  Select the options (applications) as desired.

If no fund/fy show, all users have X in the fiscal year in their profile.  No update is needed.
 SHAPE  \* MERGEFORMAT 



Log into HUMAN RESOURCES

Current Pay Frequency
____112.
Calculate September Payroll 

Payroll Processing > Run Payroll

Verify Pre-Post Reports then STOP! Correct any errors that might display.
_____113.
Print Addendum for Active Employees.  We recommend you request each employee review for accuracy and return.  Make corrections and give to the employee to review again.  

Utilities > Payroll Simulation > Addendum tab
Choose your Select criteria and whether or not you want to include Emergency Contact Info and/or Budget Information. When you click on Execute, the information will pull in. 
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_____114.   
Update the Accrual Expense table.  This table is used when accruals are pulled during payroll.  Because a prior fiscal year was used during August Accruals, it will be necessary to tell the system to use the current fiscal year.
Tables > Accrual Expense

· Change the fiscal year to reflect the desired Fiscal Year.  The only funds that should be listed on this table are those used in Payroll. 
· If you added a new fund and pay salaries from it, make sure it is listed here. Add if needed.
· Save

[image: image78.png]



____115.
Update FICA Tax table in Current Year Payroll.  
HR > Tables > Tax/Deductions > FICA Tax Tab
· Enter Calendar Year 2021. 
· Retrieve. 
· As of now, we have no updated rates for 2021.  (Those usually come in December or January.)  For now, we will enter 2020 amounts. The table should look like the following.

· Save so TxEIS can calculate future payroll amounts and accruals as needed. 
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_____116.
Update the Unemployment Table. 
HR > Tables > Tax/Deductions > Unemployment Tab
Enter Calendar Year 2021 and choose Taxable or Reimbursable as desired. 
Taxable
· Retrieve.  
· If you use Taxable, enter the Unemployment Rate. (Verify with your Insurance Career)  
· The Maximum Gross Salary should equal $ 9,999,999.99.
Reimbursable

· Select Reimbursable if you only send money after claims are filed. 
· Enter the Unemployment Rate of zero if reimbursable. 
· The Maximum Gross Salary should equal $ -0-
· Save
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____117.
Review the Workers’ Comp Table.  From Tables > Tax/Deductions > Worker’s Comp Tab.
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____118.  Update the Pay Date Table.  From Tables > Pay Dates, enter all known pay dates for 2020-2021.  
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NOTE:  Be sure the first pay date of the school year is exactly the same as the First Pay Date of School Year on the HR District Options screen
_____119.   
Verify Payroll Accrual Calendar(s).  From Tables > Workday Calendars > Accrual Calendar tab, verify dates in your accrual calendars. Accrual codes for 10-month employees should begin with 8/31/20XX and then actual pay dates for September through August.  The pay dates for September through August 2021 should match the pay dates in the pay dates table.
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Note:  Printing the Accrual Calendars from next year pay frequency Tables > Workday Calendars > Accrual Calendar tab can simplify this project.
_____120.
Verify all Employee Distributions match actual account codes in Finance.
Reports > HR Reports > Payroll Information Reports > Account Code Comparison Report (HRS6000.)
Sort by Alpha – A

Include Reports – Transaction File and Distribution file

From Date: 09012020
To Date: 09302020
Pay Status Active - A

This report should be blank. If it is not blank, verify and add account code and then rerun to this report until you have a blank report. 
_____ 121.
Review the First Payroll of the School Year Checklist to ensure everything has been completed before running your September payroll.  (Separate document available on our website.) 

Log into FINANCE

File ID 0
_____ 122.
When ready, create ASCII for auditor.  File ID 0 is available for any work needed to prepare for the annual financial audit.  When all processing, entries, etc… have been completed, create the ASCII file (a text file) and forward to your auditor.
Finance > Utilities > Finance Audit Extract
Select Current General Ledger and Extract.  Once extracted, we recommend you spot check a few lines against your General Ledger.

[image: image85]
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Celebrate!!!

It’s 2020-2021

To delete the data in the temporary EOY Accrual Data table,

Change to Current Pay Frequency

Next Year > Copy CYR Tables to NYR > Clear Next Year Tables tab.

DO NOT move any tables to the right as this will delete changes you have made to tables in NY Payroll.  Select the box to Clear EOY Accrual Data Only and Execute. Once completed return to Next Year Payroll Frequency and begin on Step 69.
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You can also Click on Fund/Yr Dropdown                                          to select a fund/year code to NOT decrement





Fed Grant & Fed Care on Employees paid from Fed Funds.





All employees should Accrue





       


Print this     Report





You will use this report again in    Step 73.





�





If you updated your employee Payroll Deduction in Next Year, then you will need to check the box to ’Carry over employee deductions.’








Check Box to include employees with Term Date if some employees left & came back to your district.





Verify only the 10 month employees.  11, 12 and 13 month employees will not have Accrued Data or Accrued Data by Job.





�





Sample rates only. Enter rate provided by your unemployment provider





Do not move items to the right. Leave right side blank.
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